
 

 

Workflow experts, from acquisition to archive – we’ve got your back(up)! 

 
 

Version 2021, Released February 2021,  Indianapolis, Indiana USA 
 

support@imagineproducts.com        www.imagineproducts.com

mailto:support@imagineproducts.com
/Users/danmontgomery/Desktop/primetranscoder.imagineproducts.com


PrimeTranscoder® for Macintosh 

2 

 

 
 

Contents 

 
 
 

 
Preface 4  Legal 
   Copyright & License 

   Limited Warranty  
 

Welcome 5  Product Overview 
 

Preferences 7  Global Settings 
   Merge & Span 
   Automation 
    

Presets 9  Standard & User Presets 
Standard Presets 
Editing a Preset 
Output Destinations 
Watch Folders 
Merge & Span Options 
Logs & Sharing 
Video & Timecode Format 
Watermarks & Color Correction 

    
Processing 23  Begin Transcoding 

Adding Files to Process 
Adjust Clip Details 
Manually Merge/Stitch Clips 
Watch Folder Processing 
Processed Details/Reprocess 
 

Logs 30  Activity Logs 
   Create Logs for the Preset 

Filtering & Details 
    
Appendix A 33  Installation & Activation 
Appendix B 35  Trouble Shooting 
Index 36  Index 



PrimeTranscoder® for Macintosh 

3 

 
 
Legal 
 

Copyright 
 
Documentation Version 3.2 for Macintosh, copyright © 2020 Imagine Products, 
Incorporated. All rights reserved. This documentation and the software 
accompanying it are the property of Imagine Products, Incorporated and are 
loaned to the user under the terms of a Limited Use License Agreement. 
Unauthorized copying or use of this documentation, the software, or any 
associated material is contrary to the property rights of Imagine Products 
Incorporated and FFmpeg.org is a violation of state and federal law. This material 
must be returned to Imagine Products, Incorporated upon request. 
 
PrimeTranscoder, Imagine HQ, myLTO, ProVu, ShotPut Pro, TrueCheck and 
PreRollPost are trademarks of Imagine Products, Incorporated. Offload with 
Confidence! and Imagine: We’ve Got Your Back(up)! are service marks of 
Imagine Products, Incorporated. 
 
PrimeTranscoder® for Macintosh copyright © 2017-2020 Imagine Products, 
Incorporated. Portions of this application use certain unmodified FFmpeg 
libraries under the LGPLv2.1 licensing. FFmpeg is a trademark of Fabrice Bellard, 
originator of the FFmpeg project. Imagine Products, Inc. claims no ownership of 
FFmpeg or any of their code that may be downloaded from www.ffmpeg.org. 
 
Imagine Products, Inc. ® is a registered federal trademark Reg. No. 4,711,231. 
 
PrimeTranscoder® is a registered federal trademark Reg. No. 5,745,087. 
 
Imagine Products, Incorporated reserves the right to change functionality and 
specifications of products documented herein without notice. All products and 
company names mentioned in this document are trademarks of their respective 
owners.  
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PLEASE DO NOT MAKE ILLEGAL COPIES OF THIS SOFTWARE 
 
The software you are using was produced through the efforts of many people: 
independent producers, production studios, programmers, distributors, retailers 
and other dedicated workers. 
 
The costs of developing and delivering to you this and other software programs 
are recovered only through software sales. The unauthorized duplication of 
personal computer software raises the cost to all legitimate users. 
 
In addition, the same federal copyright law protects this software as your 
organization's video productions. Copying software for any reason other than to 
make a backup is a violation of law. Individuals who make unauthorized copies of 
software may be subject to civil and criminal penalties. 
 
Imagine Products, Incorporated supports the industry's efforts to fight the illegal 
copying of personal computer software. 
 
WARNING! Copyright law and international treaties protect this computer 
program.  Unauthorized reproduction or distribution of this program, or any 
portion of it, may result in severe civil and criminal penalties, and will be 
prosecuted to the maximum extent possible under the law.  
 

License   
 
Please refer to the End User License Agreement (EULA) terms that you agreed to 
during download and installation of the application. The EULA is accessible from 
the Help menu on the website. Imagine Products, Inc. reserves the right to update 
the EULA with notification. By using this application you consent to the EULA 
terms. 
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Welcome 

 

 
We're pleased that you've chosen PrimeTranscoder™ to automatically convert 
your camera footage to movies of various resolutions and types. PrimeTranscoder 
is fast, and recognizes over 20 different video camera formats including high 
definition image sequences. 
 

 

Overview 
 
PrimeTranscoder can be fully automated using watch folders, or you can manually 
add clips to process. It can simultaneously output edit quality ProRes files while 
making web shareable, compressed, watermarked clips with burned in timecode 
saving you time. 
 
GPU Acceleration and CPU core distribution takes advantage of all of your 
computer’s processing power to make transcoding as fast as possible. 
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Use any of the supplied Standard Presets or create your own customized User 
presets. All processing options are on the Preset level allowing maximum 
flexibility. For example, you can have separate Watch folders and output 
locations for each preset and video type, etc. 

 
PrimeTranscoder automatically merges camera-spanned clips to create a single 
output video. Or you can manually choose clips to merge (stitch) together as 
needed. Easily apply color correction to the output as well as burning in a 
watermark (such as your company’s logo or the file name) and frame accurate 
time code. 
 
You can also manually drag & drop just desired files or folders of clips into the 
configuration queue. Begin processing and the files are analyzed according to 
your active Preset instructions, a list of the movies and the status of their 
processing is displayed.  
 
Another way to add files is to use the automated watch folder option—it 
constantly checks designated folder(s) for video files. Watch Folders are 
specifically designed for use with folders where new files are being dynamically 
added (such as offloading using ShotPut Pro™).   
 
Right click on items in the 
queue or completed items to 
open details.  
 
We think you’ll agree, 
PrimeTranscoder is a powerful 
yet easy to use transcode 
application.  
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Preferences 
 
 
 
In addition to individual Preset options, there are a few settings that affect overall 
application performance and usage. Under the Applications Menu click 
‘Preferences’. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
The first setting controls how much of your computer’s resources 
PrimeTranscoder is allowed to use. For optimum results, set the maximum 
number of concurrent transcodes to your computer’s number of cores.  
 
You can adjust how frequently PrimeTranscoder interrogates watch folders to see 
if anything new has been added. Keep this setting higher to avoid ‘time-outs’ 
while the application is scanning the indicated drive locations. 
 

Merge & Span 

 
‘Merge complete volumes’ automatically stitches all movie files (from a single 
source Folder) into a single output file in sequence by timecode (if any). Clips may 
be of various formats and sources. 

 
NOTE: Refer to Timecode section of Presets for options regarding maintaining 
component timecodes in a merged file or applying a new timecode track to 
resulting merged clips. 
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‘Merge spanned clips’ refers to those volume types where clips have been 
separated by camera file size limitations. With this option, clips are only rejoined 
if the source material contains instructions on which clips are a continuation.  
 
While the timecode track of the resulting master file for spanned clips should be 
contiguous, this option does not rely on timecode values to determine whether 
to stitch together clips. 
 
You may choose to Output only the resultant merged file, or Output converted 
individual component files plus the merged file. 
 

Automation 

 
Choose how transcodes will be initiated. With the Manual option you’ll click the 
Begin button at the top right of the Queue to start each transcode. 

 
Watch folder transcodes can be initiated automatically while Drag & Drop items 
will still require manual begin method. 
 
Or you may choose for all transcodes (watch folder and Drag & Drop items) to 
begin automatically. 
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Presets 
 
 

 
 
Presets are a set of instructions on how to transcode video files and where to 
place them when complete. 
 
PrimeTranscoder is supplied with several ‘Standard Presets’ that we've found 
balance file size, speed of processing and quality of image.  
 
You may also create User-Defined presets to suit your specific needs. To add a 
preset, click the Plus (+) button below the preset lists. 
 
To enable a preset, check the box beside 
it. Numerous presets may be active at 
the same time. 
 
You may ‘Hide’ or ‘Show’ the groups of 
presets (Standard and User presets). 
 
Presets may also be sorted by Name or 
Enabled (selected). To sort, click the 
button beneath the preset lists. 
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Presets may be duplicated for easier setup of similar configurations. Right click 
on a selected preset to open the options menu. 
 
A preset may also be exported/imported between 
computers or users. To remove a User defined 
preset, select it and press the DELETE key on your 
keyboard, or right click on it and choose Remove 
Preset. 
 

Standard (Built-In) Presets 
 
 PrimeTranscoder comes loaded with a number of handy standard Presets that 
are configured for commonly used transcodes. 
 
▪ ProRes4444 
▪ ProRes422 
▪ Avid DNxHD 
▪ H.264 
▪ PreRoll Post 
▪ Current iOS/tvOS 
 
 TIP: Standard Presets do not allow certain format changes (video codec, 
dimensions, etc.).  
 

Editing a Preset 
 
Each Preset has a large number of customizable options. To configure a preset, 
click the pencil button to the right of the preset.  

 
Only one preset may be edited at a time. 
To save your changes, click the Close (X) 
button at the top of the window. Output 
format settings in Standard presets may 
not be edited. 

 
To add a preset, click the Plus (+) button below the preset lists. 
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At the top of the editing dialog are the following tabs: 
 
• General File Options 
• Video & Audio Formats 
• Timecode Format 
• Watermarks 
• Color Correction 
• Preview 
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General Tab  

 
The General Tab contains many of the key properties that may be customized for 
the selected preset: 
 
• Preset Title 
• Output Location(s) 
• Watch Folder(s) 
• Merge & Span 
• Logs & Sharing 
• Formats to Transcode 
 

Title 

 

The title is the name that is shown in the Preset list. With the preset open in edit 
mode, select the title text and type in a name. 

 
NOTE: Standard preset titles may not be edited.   

 

Output Destinations 

 
Output locations are the root folders where finished video files will be placed. 
You may output to several locations at the same time. You can also turn output 
locations ON or OFF by checking the box beside them. 

 
To add a path, either drag and drop a folder from Finder directly into the list, or 
click the Plus (+) button at the bottom of the list and browse to the desired folder.   
 
TIP: Click the Finder icon to the right of the location to open Finder. 
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To remove a location, highlight the path(s) you want to remove in the list and 
click the Minus [-] button at the bottom of the Output destinations list, or click 
the Delete key. 

 
TIP: To place output files into sub-folders named after the SOURCE folders they 
originated from, check the box ‘Output file paths maintain volume structure’. 
For example, a file originating from a PROJECT-A folder will have transcoded files 
placed in a PROJECT-A inside the root output destination. 
 

Watch Folders 

 
PrimeTranscoder’s unique automated watch folder option constantly checks 
designated location(s) for the addition of video files. Watch Folders are 
specifically designed for use with folders where new files are being dynamically 
added (such as offloading using ShotPut Pro™).   
 
TIP: PrimeTranscoder and ShotPut Pro work well together on the same computer 
since video processing is CPU/GPU intensive while copying files is I/O intensive. 
 
As video files are identified (based on the Formats to Transcode you choose) 
they’ll begin processing. 

 
Add Watch Folder locations by dragging and dropping folders, or mounted 
volumes, directly into the list. Alternatively, click the Plus (+) button at the bottom 
of the Watch Folders dialog to browse to it.  
 
TIP: Click the Finder icon to the right of the location to open Finder. 
 
To remove locations from the Watch Folder list highlight the item(s) and click the 
Minus [-] button, or click the ‘Delete’ key.   
 
CAUTION! If you ONLY want to manually select files for transcoding, remove or 
uncheck Watch Folders in the list.  
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To place output files into sub-folders named after the SOURCE folders they 
originated from, check the box ‘Output file paths maintain watch folder 
structure’. 

 
 
  
 

TIP: Watch folders are designed to automatically skip previously processed files, 
even between software uses. To override this feature and reprocess the entire 
Watch folder contents, clear the Logs. 
 

Merge & Span 

 
Global Merge options are configured under Preferences. You may use these, or 
instruct PrimeTranscoder to override them on a Preset level.  
 
Select CUSTOM and choose how you’d like just this preset to behave. 
 

 
NOTE: Setting custom Merge instructions here DO NOT modify your global 
Preferences; these are Preset specific. 
 

Logs & Sharing 

 
PrimeTranscoder maintains a history of transcoding activities for Presets with 
Logs enabled.   
 
Inside each Preset you’d like to track output activities, select ‘Create log entries 
for preset’ before processing. 
 

 
 
TIP: After transcoding, select ‘Logs’ from the Windows menu.  
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External applications (e.g. Axle Video) that have been enabled with 
PrimeTranscoder’s communications module may invoke presets and pass videos 
to it remotely for processing.  To allow a preset to be called externally, select 
‘Share preset with outside Apps’. 
 

Formats to Transcode 

 
PrimeTranscoder can process virtually any video file format including over 20 
camera types. Allow the software to automatically determine and process valid 
media files, or you may restrict it to look for only specific types. 
 
TIP: ‘Limit transcoded formats’ may be useful in situations where a designated 
watch folder contains multiple file types, but you only want to process certain 
formats. 
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Video & Audio Formats 

 
Specify video and audio output options including format, data rate, dimensions 
and audio source channels and tracks. 
 

 
 
Select ‘Use GPU’ acceleration for best performance. Select from internal GPUs 
and external GPUs (e.g. BlackMagic Design eGPU).  
 
If you have a Red Rocket hardware accelerator the option to enable it will also be 
shown here. 
 
TIP: Turn off GPU acceleration when other applications running concurrently may 
require this resource for smooth performance (e.g. video player or editor, etc.). 
 

Video Format Options 

 
Choose the ‘Video Format’ type (e.g. H.265, Avid DNxHD, H.264, H.265, ProRes, 
etc.) and the file extension to apply to transcoded files if appropriate. You can 
adjust the desired ‘Frame Rate’ or simply ‘Match Source’ in most cases.  
 
Certain video formats (e.g. H.264) allow further customization of ‘Video Data 
Rate’ such as ‘Overlay Quality’ and ‘Prepare for web streaming’ attributes. 
 
NOTE: H.265 output requires OSX 10.13 or higher operating systems. 
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Sizing 

 
Select the ‘Dimensions’ of the output file. The options may vary depending upon 
the Video Format chosen. If you need a very specific size not listed you may 
choose Custom and set the pixel size manually.  
 
If you choose ‘Custom Dimensions’, you’ll need to further define how to scale the 
frame. ‘Match Source Aspect‘, ‘Fit to Frame‘ via ‘Stretch‘ or ‘Letterbox‘, or ‘Crop‘.  
 

 
To Crop, click the icon to a dialog to set an anchor point. 

 
You may also adjust ‘Color Space’, ‘Key Frames’ and ‘Profile Levels’. 
 

Audio Format Options 

 
Select the ‘Audio Format’ to ‘Match Source’ or other format types (which may be 
restricted based on the video format chosen).  

 
When you select a specific audio format, also choose the desired ‘Audio Quality‘, 
‘Sample Rate‘, ‘Track Layout‘ and ‘Channel Layout‘. 
 
You may further customize which audio tracks to Include or Exclude. For example, 
you may not want the camera’s built-in audio tracks included when choosing 
external audio files. 
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Timecode Format 

 
There are several options for controlling how timecode information is inserted 
and presented in your transcoded clips.  
 

 
 

Timecode Track & Overlay 

 
Timecode information is independent of video tracks. While many Mac-based 
applications generally expect QuickTime timecode tracks, other file types may 
insert the information into the file header (e.g. MXF files).  
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Choose ‘Insert a timecode track’ option to include timecode in the output file.  

 
‘Insert a timecode overlay on the video track’ burns visible timecode numbers 
into the video frames.  You can specify how the timecode will appear and where 
it will be located on the transcoded video.  
 

 
CAUTION! A timecode overlay is a physical augmentation of the video track of the 
transcoded file. Unlike a QuickTime timecode track, a timecode overlay physically 
burns a timecode sequence into the video frames of the transcoded file that 
cannot be separated from the video track. 
 
The location of the timecode burn can be adjusted by setting the anchor point to 
one of the 9 areas of the frame. 
 
You can adjust the ‘Font Color’, ‘Box Color’ and ‘Font Size’. Click on the color icons 
to open the color selection window.  

 
NOTE: All changes in Timecode Overlay Font and position options are visualized 
in the Preview window (choose ‘Preview’ icon and click in on the screen to 
refresh). 
 

Timecode Value  

 
Select ‘Match Metadata’ to set the ‘Start Timecode’ based the source movie's 
properties and available metadata. Alternatively, you may choose a start time of 
zero, a custom input value, or use the source file’s creation date/time 
information.  
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‘Frame rate’ may also be gathered from the video source file, or forced to 
conform to desirable rate. 
 
CAUTION! Forcing a frame rate will override any existing metadata of source files 
and therefore should not be used if a match-back workflow is expected. 

 
If you’ll be merging clips, the resulting merged file may have a continuous 
timecode track, or ‘Maintain component timecodes’ (which may or may not be 
contiguous).  
 

Watermark Options 

 
Click the Watermark icon to specify an image or text to be overlain (burned) into 
your transcoded movies.   

 
To add a watermark image, select ‘Insert a watermark image’ click the Plus (+) 
button to browse to the image file or drag the file into the Drop Images Here box. 
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After adding an image, specify its size by changing the width and height values (in 
pixels).  
 
Set the anchor point of the watermark image on the video frame.  
 
TIP: You may open the Preview and right click on the image to adjust its desired 
location. 
 
TIP: Changing one of the scale values (width or height) will automatically adjust 
the other value to preserve the aspect ratio of the supplied image file if you click 
in the next box (e.g. change the width then click in the height box). 
 
You may also burn text into the video frames. Select ‘Insert text’ and ‘Use source 
file name’ to insert the name of the source file (a handy visual match of proxies 
to source material). 
 
Alternatively, select the ‘Custom Text’ option and type into the textbox. Then 
specify how the text will appear and where it will be located on the transcoded 
video.  
 
You can adjust the size, font, text color and background (Box Color). Drag the 
slider to change the text size. Click on the ‘Font Color’ to open the color selection 
window.  
 
Text may be displayed directly upon the video frame (transparent around the 
text), or you may specify a ‘Box Color’ around it of a contrasting color. 
 
The location of the text insert can be adjusted by setting the anchor point to one 
of the 9 areas of the frame. 
 
NOTE: Text overlay and position options are visualized in the Preview window 
(click ‘Preview’ tab and click in on the screen to refresh). 
 

Preview 

 
Click the Preview icon to see how all of your watermarking and timecode burn 
options will appear in the transcoded movie.   
 

 
 
The Preview window aspect ratio matches that of the Preset’s video codec, so 
you can accurately set the relative location of visual items.  
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Color Correction 

 

You can automatically apply a color correction to output files as they’re created. 

 

Select from your list a Color LookUp Tables (LUT) to use. To load a LUT, click the 
Plus (+) button and browse to it.   

 

You may also load LUTs into PrimeTranscoder 
from the ‘Color Correction’ menu found under 
the ‘Window’ menu.  

In that window, Drag & Drop a Color LUT file 
into the list, or use the Plus (+) button to 
browse to a file. 

To remove a LUT from the list, select it and 
press the ‘Delete’ key on your keyboard. 
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Processing 

 
Once you’ve modified and activated a preset, you’re ready to begin processing. 
Drag and Drop just desired files, or entire folders of clips, into the configuration 
queue (center work area—‘drop files here’). Files may be selected from the upper 
left column browser, or directly from Finder. 

 

Begin Processing 
 
If you’ve configured Preferences to ‘Manually begin all transcodes’, thumbnails 
of the clips waiting processing will appear in the queue area. You may add as 
many clips as you like or begin processing them at any time.  

 
To start processing all files in the queue, click the ‘Begin’ 
button at the top right of the application.  To ‘Clear’ the 
queue, click the eraser icon. 
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You may begin processing individual files by right clicking on 
the file in the queue and choose ‘Begin’. Just that clip, 
instead of the entire queue, will begin processing. 
 
Manual processing gives you the opportunity to examine the 
details of source files added to the queue. You can select just 

a portion of the file to process using the ‘Play/Trim’ dialog or 
select various clips to manually ‘Merge’ (stitch) together.  
 

Adjust Details 
 
Right click on the clip and select ‘Details’ to open the information panel. 

 
In the Details panel, you can examine its metadata such as duration, timecode, 
size, date and format, etc.  
 
TIP: Click the Finder icon beside the file path to browse to the source file location. 
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On the Details panel, click the Video icon for video information such as codec, 
frame rate, dimensions, color space and pixel format, etc.  
 
Select the Audio, Timecode or Color Correction icons to override Preset settings 
with custom ones for just this clip. For example, you may manually exclude 
certain audio files or add external ones.   
 
Start Timecode and frame rate can be customized for just this clip. And you can 
apply a loaded LUT (color look up table) to just this clip. 
 

Play/Trim Clips 
 
PrimeTranscoder has a built-in player function. You can play clips in their native 
form (before processing) as well as output files (after 
processing) to ensure they have the desired properties. 
 
To open the player, right click on the file in the queue and 
choose ‘Play/Trim’. 
 
Click the ‘Play/Pause’ button on the lower left of the 
Player Window to begin playing the clip. You may also use 
the ‘Spacebar’ for Play/Pause, or the drag the ‘Jog/Shuttle’ to scrub. 

 
From the VIEW menu you can ‘Enter Full Screen’ to maximize the player window. 
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Click the ‘Trim’ (scissors) icon to open the trim selection bar.  Select IN and OUT 
points within the clip to instruct PrimeTranscoder to only process that portion of 
the clip. 
 
NOTE: Trim is only available on Source files, not clips already output. 
 
Choose the Time, Frame Number or Timecode format to display. The player also 
offers a ‘Loop’ option and adjustable volume control. 
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Merge (stitching) 
 
Select two or more clips in the queue and right click to ‘Merge’ (stitch) them 
together. The files can be from any sequence of clips, volume or format. 
 

 
 
Merged clip sequences will be indicated by a stacked video icon in the upper left 
corner. 
 

 
 
You may adjust the order of files to be merged. Right click on a merged clip and 
open its ‘Details’. Then drag the clips in the left column into the desired order. 
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Watch Folder Processing 
 
Another way to add files to the queue is to use the automated watch folder 
option. Watch Folders are specifically designed for locations where new files are 
being dynamically added (such as offloading using ShotPut Pro™).   
 

 
To use Watch Folders, open the preset and add one or more location to monitor 
and check the box beside them to enable.  
 
Presets containing enabled Watch Folders are indicated in the preset list by an 
eye icon. 
 

Begin Watching 

 
Click on the ‘Watch icon’ to ‘Begin’ watching. The icon will turn blue. 
 
TIP: In Preferences select ‘Watch-Folder-based transcodes begin automatically’ 
to turn ON watching while manually starting only Drag & drop items in the queue. 
 
Adjust the frequency of watch folder interrogation under Preferences. Typically 
this should be several seconds apart to avoid processing slow downs. 
 
IMPORTANT: Watch Folders use Logs to track the history of completed files. You 
must have ‘Create log entries for preset’ enabled in the preset Logs & Sharing 
section in order to skip previously processed files when next launching the 
application. 
 
NOTE: ‘Clear Logs’ in under the Logs window resets Watch folder history, so any 
enabled Watch folders will be processed again in their entirety.  
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Processed Clip Details 
 
Processing status is indicated in the right column list. Right click on a clip for 
options. If the file is still in process, you can cancel it, or all items in process. 
 

 
 
You may ‘Reprocess’ or ‘Remove’ Canceled or Failed Items. Once processing is 
complete you can open the clip’s details by right clicking on it. 
 

 
NOTE: Choose between details for the source media, or transcoded movie. 
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Activity Logs  

 
 

 
PrimeTranscoder maintains a history of transcoding activities for Presets with 
Logs enabled.  
 
IMPORTANT: These logs are also used for Watch folder history (tracking what’s 
been processed previously.) 
 
Inside each Preset you’d like to track output activities, turn on Logs before 
processing. 
 

 
 
 
After transcoding, select ‘Logs’ 
from the ‘Windows’ menu.  
 

 
Each time PrimeTranscoder finishes 
processing a file it chronicles all major details 
of the activity.  
 
Here you can review recently completed 
tasks.  
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Filtering options help locate specific transcodes out of a potentially large list. Sort 
by File Name, Preset used, Status Date range or output Format.  

 
Select a clip from the log list to expose its details. Choose ‘Source’ or ‘Output’ 
files to display. File information, Video format and Audio metadata are available 
for each.  
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TIP: Frequent use of PrimeTranscoder can result in a very large activity log.  
 
It is recommended that the logs be regularly purged (‘Clear Logs’) to remove 
irrelevant entries. 
 
CAUTION! Clearing Logs also deletes Watch Folder history so any enabled Watch 
folders will be entirely processed again! 
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Appendix A – Installation 
 

 
 
This section details the initial required steps before using PrimeTranscoder. 
Included in this section are instructions on installing the program, system 
requirements and registration. Skip this section if a registered copy of 
PrimeTranscoder is already installed on your system. 
 
You may be asked for the administration password for the computer. The default 
location is the Applications folder. 
 

Activation 
 
PrimeTranscoder activation requires web access to our server to register the 
software for use. When you purchased the application, a PrimeTranscoder seat 
was added to your account on our website. Upon first launch, the software will 
attempt to connect to our server and prompt for you to activate. 
 
TIP: Activation information is stored on the system level independent of user 
preferences, so multiple profiles on the same computer may access the 
application as long as you install under the ADMIN user profile for your 
computer. 
 
Just enter your account email and password for fast, easy activation, or enter 
the individual serial number. 
 
If you don’t have an Internet connection on the target computer perform a 
manual activation. You may use a QR code reader app on your smart phone to 
quickly go to the appropriate page on our activation site to receive the manual 
activation code, or use the link provided to type in the computer ID. 
 
PrimeTranscoder is a single user license. If you're upgrading to a new 
computer, or need to transfer the software, be sure to ‘Deactivate’ from the 
‘Application menu’, just above ‘Quit’. 
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System Requirements 

 
The minimum Macintosh configuration is: 
 
-Mac OS  10.15 - 10.11 
-4 GB RAM 
-16 GB free disk space 
 

How to Register 
 
If you’ve purchased from our webstore, you’re already registered in our system. 
If you purchased from a reseller or other method, the reseller or Imagine can 
transfer ownership to you. You must have an account on our website to run the 
software and receive customer support. 
 
Upgrades are released from time to time and the only way you'll get these is to 
be registered.   
 
We may also send you periodic electronic news. Generally we notify of new 
products and trade shows, commentary and stories of interest from other users 
just like you. Let us know what you’re up to (publishing your stories is an 
inexpensive way to network within the production community). 
 
Follow us on Social Media for timely and helpful information.  
On Twitter: @imagineproducts  
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Appendix B - Trouble Shooting 
 

 
Throughout the program, reminders and error checks help to anticipate trouble 
spots in the program while preventing inadvertent data loss. If a message appears 
that is unclear, check the Help topics or refer to the appropriate section of this 
guide for further explanation.   

Technical Support 
  
This product was designed to be easy to use and we want you to feel at home as 
you navigate through it. This guide should address the most often asked 
questions along the way.  
 
Before asking for Technical Support, please be sure your software is up to date. 
The problem you’re experiencing may have already been reported by another 
user and already addressed.  

Check for Updates 

  
From the application's menu, select CHECK FOR UPDATES to connect to our site 
and determine whether a newer version of the software exists. You may also 
download updates from the ACCOUNT>VIEW LICENSES page of the website.    
 
TIP: It’s a good idea to keep PrimeTranscoder up to date for best performance 
and to get support for all the latest camera types. 
 

Frequently Asked Questions 

 
From the Help menu, click FAQs to quickly go to the list on our website. 
 

Contacting Imagine Products 

 
If updating the software and FAQs haven’t addressed your problem, from the 
Help menu click Feedback to initiate a support ticket, or send an email to 
support@imagineproducts.com. Please also include the Diagnostic Log found 
under the Help menu. 
 
 

mailto:support@imagineproducts.com
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